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SECURITY 

 

Please keep your laptop with you at all times. If it is necessary to step away from the 
computer, make sure it is password protected and/or secured with a laptop lock. 
Password protect your laptop by using +L on the keyboard. A password is required 
to log back in. 

LOGGING IN 

Training Login 

1. Double click the training application icon to open the login window. 
2. Type the training username in the Username field. 
3. Type the training password in the Password field. 
4. Click OK. 

Daily Login 

1. Log into Cerner. 
2. Click the icon for PowerChart. 

Logging Out (Exit) 

1. From any window within the application, click the Red X ( ) at the top right corner of the window to 
log out. 

 

POWERCHART OVERVIEW 

The PowerChart Overview will provide an overview of the main sections of the IRIS windows, how to view a 
resident’s chart, and use common functions. 

 Navigate to the PowerChart window from the Pharmacy Patient Monitor window. 

 
 

Pharmacy Patient Monitor Window 
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1. Click on a resident’s name from the list on the left of the screen. 

 The PowerChart window displays. 

 

PowerChart Window Overview 

 

Title Description 

1. Title Bar Displays the application that is currently open, and the name of the individual logged in. On 
the right, there are buttons to minimize, maximize, or close the application. 

2. Menu Bar Includes the following menus: 
Menu Description/Functionality 

Task Change a password, suspend the application, view report, print, refresh 
the window, or exit the application. 

Edit Cut, copy, paste and delete. 

View View the Pharmacy Patient Monitor, Consults and Interventions, and 
Resident List. 
Toolbars can be customized by following these steps: 

1. From the View menu, click Toolbar. 
2. Click Navigation Toolbar, and select which toolbars to view. Any 

toolbar with a check will be visible; any toolbar without a check 
will be hidden. 

3. Click Notifications Toolbar to check (view) or uncheck (hide) the 
Notifications Toolbar. 

Patient Perform a resident search, view a recent resident, input new 
orders/allergies/medication list or notes, or complete a Resident 
Management Conversation. 
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Chart This menu contains all of the items that are also located on the Chart 
menu, which displays on the left side of the window when a chart is 
open. The following functions are also available: 

 Clinical Calculator, Message Sender, AdHoc Charting, Resident 
Education, Resident Pharmacy, Tear Off This View and Attach to 
Chart 

 View who has accessed the current chart, and close the current 
chart 

Links Access CareTracker. 

Tip ► Use CareTracker to view resident information such as bowel 
history and seizure history. 

Navigation Navigate through the application with the following functionality:  Zoom 
in or out, change the window orientation to rotate left, right or flip, go to 
the previous, next or a specific page in a document, perform a search 
within the window, go back, go forward or go to the Home window. 

Help Links for window specific help, Navigation, HNA Help topics, Support 
Center and About Power Chart. 

 

3. Resident 
Toolbar 

Provides general information about the resident.  

4. Refresh Keeps track of how many minutes have lapsed since the window was last refreshed. Click 
this at any time to refresh the window and return the minute counter to zero. 

5. Recent drop-
down menu 

Displays the most recent nine residents viewed. 

6. Chart Menu A series of bands that provides easy navigation to the functionality within Powerchart.  

 

RESIDENT SEARCH 

Resident Search 

1. From the Resident Toolbar, click the down arrow to the right of the Search box to select search type. 
2. Select to search by MRN, Name or FIN. 
3. In the Search box, type the search criteria. 
4. Press Enter on your keyboard. 
5. From the Resident Search pop-up window, double click the resident or encounter to open and view. 

Note ► If the Resident Toolbar is hidden, the Search bar is not available.  

 

Resident Toolbar 

Quick Search 

1. From the Resident Toolbar, click the search icon ( ). 
2. From the Resident Search pop-up window, type in the Phone Number, Encounter Identifier, Person 

Identifier, Last Name, First Name and/or DOB to conduct the search. 
3. Click Search, or press Enter to display the search results. 
4. Double click the resident or encounter to open and view. 
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Open Multiple Residents at a Time 

1. Perform a Resident Search or Quick Search, as indicated above. 
2. Each new resident opens in a new tab on the Resident Toolbar, and also in a new window. 
3. Click the name of the desired resident to move between charts. 
4. Click the X next to the resident’s name to close a chart. 

Note ► The maximum number of resident charts open at any time is two. 
If trying to open a third chart, a pop-up displays with a request to 
close one chart. 

 

Multiple Resident Tabs 
 

RESIDENT DEMOGRAPHIC BANNER BAR 

Resident Demographic Banner 

Located at the top of the window above the Resident Summary and Chart menu, the Resident Demographic 
Banner displays when a chart is open. Displayed in blue, it provides pertinent information about the resident’s 
demographics. 

Note ► When two resident charts are opened at one time, the second 
resident’s banner displays in yellow. 

 Resident Name 
 Date of Birth 
 Age 
 Dose Weight 
 Sex 
 Medical Record Number 
 Attending Physician 
 Allergies 
 DADS Pre-Admit status 
 Residential FIN 
 Admit/Discharge Dates 
 Location 

 
Several items within the Resident Demographic Banner are clickable links, as shown in the screen images below: 

 
Resident Demographic Banner 

Note ► These screen images appear with jagged edges in this document, 
as they are showing small portions of the window, versus a view 
of the entire application. 
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 Click the resident’s name to display a pop-up window with general resident information including: Age, 
DOB, Sex, Race, Marital Status, Language, MRN, SSN, Religion, Address, Phone Numbers, and Insurance 
Number. Information cannot be edited within this window. 

 

 
Resident Demographic Banner: Click the resident’s name 

 
 Click Residential FIN to display a pop-up window with the following information: Name, Registration 

Date/Time, Discharge Date if applicable, DOS, Nurse Unit, Room, EMC, EMC Phone, FIN Number, Service 
type, and Visit Reason. Information cannot be edited within this window. 

Resident Demographic Banner: Click Residential FIN 
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 Click Allergies to display a pop-up window, which displays a list of allergy information including: 
Substance, Category, Type, Severity, Reactions, Interaction, Comments, Source and Reaction Status. From 
the Allergy Profile, you can add, review, and update allergy information.  

 
Resident Demographic Banner: Click Allergies 

 

TOOLBARS 

Resident List 

Click Resident List under the Menu Bar to display the Resident List window. Click the tabs across the top of the 
window to view all residents within each list. 
 

Note ► These lists align with the views in Pharmacy Patient Monitor. 
Please see the Create a New View in Pharmacy Patient Monitor 
lesson in the Navigation section of this document for instructions 
regarding custom lists. 

Suspend 

From the Action Toolbar, click Suspend to close and lock the resident’s record. A password is required to reopen 
the application.  
 

Tip ► Remember to save your resident updates before clicking Suspend.  

 

 

Suspend the application if it is necessary to step away from the computer, to 
prevent unauthorized individuals from viewing private resident information. 
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Calculator 

From the Action Toolbar, click Calculator to display the Online Clinical Calculator pop-up window. 
1. From the Identify Formula drop-down menu, select the desired formula. 
2. Use a keyboard or the Keypad on the right of the pop-up window to type all required fields. 
3. Press Enter. 

 

Online Clinical Calculator 

Note ► Click Calculator on the bottom left of the pop-up window, for 
basic calculator functionality. 

 

Calculator 
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AdHoc 

AdHoc Forms allow a provider to document required and important information in pre-defined templates and 
easily add the form to a resident’s chart. Open a resident’s chart. From the Action Toolbar, click AdHoc to open 
the AdHoc Charting pop-up window to chart unordered results and documents.  
 

Note ► This section addresses the forms initiated by pharmacy. All other 
forms are accessed using the Forms Browser band in the chart 
Menu within the resident’s chart.  

 
1. Double click a folder in the left column of the window to select the charting category. 
2. In the center of the window, select the task that needs to be charted. 

  

AdHoc Charting 

3. Click Chart. 
4. Another pop-up window displays fields that are specific to the task being charted. Fill out all pertinent 

information. 

Note ► The date/time defaults to the current date/time. The time is 
displayed in military time. To change to the date or time, click in 
the field and type in the correct numbers, or use the up and down 
arrows to adjust the date/time as needed.  

5. Once the form is complete, click the sign form icon ( ). 
 

Patient Education 

Patient Education provides discharge instructions, release forms, follow-up information, equipment information, 
and medication and diet directives.  
 
Open a resident’s chart. From the Action Toolbar, click Patient Education to add new education details.  

1. From the Patient Education pop-up window, use the search field to search for a specific type of Patient 
Education. 
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Tip ► Leave the search field blank and double click the type of Resident Education in the left column under 
Patient Education. 

2. From the search results window to the right, double click the Click here for instructions link. 
3. Double click the topic, to display the selected educational information on the bottom of the window. 
4. Click Sign to sign the Resident Education before saving to the chart; click OK to close the pop-up window 

and save all information to the chart; click Print to print; click Cancel to close the pop-up window without 
saving. 

 

 
 

Patient Education Pop-up Window 

Note ► Add as many Patient Educational materials as needed to a chart. 

To delete one, click the Red X ( ) next to the topic to delete. 

Add 

Providers add Order, Allergies, Medication List or Note from the Action Toolbar, or from the Chart menu. 
Pharmacist orders will be covered later in the manual. 

Note ► The ability to add varies based on positions and roles. Please 
adhere to current policy regarding the addition of orders, 
allergies, and notes. 

 Add an Order 
1. From the Chart menu, select +Add next to Orders. 
2. From the Orders window, an order can be added but there must first be a diagnosis to associate 

with the order. 
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3. On the top right of the window, use the drop-down menu to select the type of order to add: 
Document Medication by Hx, Inpatient or Prescriptions. 

4. In the search field, type the type of Order to search for then press Enter. 
 

 
 

5. From the search results, select the appropriate order. 
6. For non-physicians who are adding an order, the Ordering Physician pop-up window displays. 

Type the ordering Physician’s name. The order date and time default to the current date and 
time. 

7. In the Communication Type field, select Phone, Verbal, Signature Required or Written 
(Paper)/Fax, then click OK. 

Note ► If a physician is adding the order, steps 6 and 7 are omitted. 

8. Click OK. 
9. Complete the required details associated with the medication. 

 

 
 

10. On the Orders window, click Sign to complete the order. 
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 Add an Allergy 

Note ► Allergies are entered by the provider; however, only a pharmacist 
is allowed to free text an allergy. Free text allergies will not fire a 
Multum allergy alert. 

 

 Navigate to the Allergies window.  

 

 
 

Allergies Window 
 

Note ► Orders cannot be placed until allergies are documented. 

 
1. From the Chart menu, select +Add next to Allergies. 
2. On the Allergy window, from the Type drop-down menu select Allergy, Contraindication, 

Intolerance or Side Effect. 
3. Mark the Free text check box. 
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 The Warning pop-up window displays. 

 
 

Warning Pop-Up Window 

 
4. Click OK. 

 

 The No Allergy checking is available for free text substances message displays. 

 

 

Allergies Window 

5. In the Substance field, type the allergy. 
6. On the Allergies window, from the Severity drop-down menu select Mild, Moderate, Severe or 

Unknown. 
7. From the Category drop-down menu select Drug, Food, Environment or Other, then complete 

any other fields that apply. 
8. Click OK to save the entry and stop entering allergies. Click OK & Add New to save this allergy 

entry and add a new entry. 
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 Add a Note 
1. From the Chart menu, select +Add next to Notes. 
2. From the Notes window, any notes that have been added to a chart can be viewed. 
3. On the left side of the window, select the folder that contains the note that needs to be viewed. 

The note displays in the center of the window. 
4. Sort the notes view by selecting a radio button: By type, By status, By date, Performed by or By 

encounter. 
5. Use the up and down arrow buttons to scroll up and down through the available notes. 

6. Click the new icon ( ) to add a new note. 
7. From the Add Document pop-up window, select the type of note to add. 
8. Complete all fields on the window and type the note. 
9. Complete the note by: 

 Clicking Sign – Completes the documentation, and publishes the note to the resident’s 
chart 

 Clicking Save – Saves the note without signing it, but leaves the note window open; this 
provides the ability to make revisions at a later time. The status of the note will remain 
as In Progress until it’s closed 
 

Tip ► Even when temporarily walking away from the computer, it is important to always save a note to 
prevent data loss in the event of a power outage or network failure. 

 
 Clicking Save & Close – Saves and closes the note without signing it 
 Clicking Cancel - Closes the pop-up window without saving changes 

 

Add a Note Window 
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VIEW ORDERS  

Resident’s orders can be viewed from Orders window.  
 

 
 

Orders Window 
 

1. Click Orders on the chart Menu to view the Orders window.  

2. Use the check boxes in the View section of the window to filter the orders that display. 

Note ► Another way to filter the view is to use the All Active Orders, All 
Orders (All Statuses) links. 

3. The orders display on the right side of the window. 

 

FORM BROWSER 

Form Brower allows a provider to easily access, review and update any forms or completed documentation that 
has been added to a resident’s chart, and placed into the resident chart by Date.  From the Chart menu, click Form 
Browser to view all forms in a chart. All forms are displayed on the Form Browser window.  

Note ► This is where forms such as MOSES, AIMS, Consent Tracking and 
Psychiatric Quarterly Review are housed. The AMB Annual 
Wellness Visit can be viewed from the Notes band. 

 
1. Click the Sort By drop-down menu to view forms by date, form, status, encounter-date or encounter-

form.  
2. Double click a form to view its details. 
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Form Browser Window 

HISTORIES 

From the Chart menu click Histories to view family, procedure and social historical information for the resident. 

From any of the tabs at the top of the window, a new history can be added. Click the add icon ( ). Add all 
information, then click OK to save the record. 

 

Histories Window 
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IMMUNIZATION SCHEDULE 

From the Chart menu, click Immunization Schedule to view the resident’s Previous Immunizations, and Future 
Immunization Schedule. 
 

 
Immunization Schedule Window 

 

MAR SUMMARY  

From the chart Menu, click MAR Summary (Medication Administration Record) to view the medication summary. 
This window displays the dates and times that medications were administered, or are due. Hover the mouse over 
each medication to view medication details. 
 

Note ► The MAR Summary provides the detail outlined below. The MAR 
provides an overview resident’s medications and administration 
times.  
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 Navigate to the MAR Summary. 

 

 
MAR Summary 

 

1. From within the resident’s chart, click the MAR Summary band on the chart Menu. 

2. To view order information, right-click on the order.  

3. Select Order Info from the pop-up menu. 
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 The Order Information pop-up window displays. 

 
 
 

Order Information Pop-Up Window: Details Tab 

 

4. Click the tabs on the screen to view additional information. 

5. Click the exit icon (  ) to close the pop-up window. 
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 The MAR Summary window displays. 

 

 

 

MAR Summary Window: Select Event/Task Summary 

 

6. To view the event/task summary, right-click on the order again. 

7. Select Event/Task Summary from the pop-up menu. 
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The Event/Task Summary pop-up window displays. 

 
 

Event/Task Summary Pop-Up Window 
 

8. Click the exit icon (  ) to close the pop-up window. 

 

 The MAR Summary window displays. 

 

MAR Summary Window: Select Reference Manual… 

 

9. Right-click on the order again. 

10. Select Reference Manual… from the pop-up menu. 
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 The Decision Support pop-up window displays. 

 

Decision Support Pop-Up Window: Drug Reference Tab 

 

11. Click the tabs to view additional information. 

12. To print the information, click Print. 

13. To close the pop-up window, click OK. 

 The MAR Summary window displays. 

 

MAR Summary Window: Task Pop-Up Window 

 

14. Click on a MAR task to view more detail in a pop-up window.  

15. To change the time frame, right-click on the date range in the grey bar. 
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 The MAR Summary window displays. 

 

MAR Summary Window: Change Properties 
 

16. Select Change Properties… from the pop-up menu. 

 

 The MAR Summary Properties pop-up window displays. 

 
 

MAR Summary Pop-Up Window: Date Range Tab 

 

17. Select the new date and time parameters for viewing tasks in the MAR Summary. 

18. Click the Filters tab to change filters.  
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 The MAR Summary Properties pop-up window displays the Filters tab. 

 
 

MAR Summary Pop-Up Window: Filters Tab 

 

 

19. Use the check boxes under Show these selections to select filters for viewing tasks in the MAR.  

20. Click the Options tab to make additional customizations to the MAR Summary view. 
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 The MAR Summary Properties pop-up window displays the Options tab. 

 
 

MAR Summary Pop-Up Window: Options Tab 

 

 

21. Make any desired changes to options. 

22. To set these options as your default view when accessing a MAR Summary, mark the Save as Default 
check box. 

23. Click OK to save changes and close the pop-up window.  
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 The MAR Summary window reflects the property changes.  

 

 
MAR Summary Window: Property Changes Reflected 

 

24. The changes are now reflected in the MAR Summary window.  

 

 Change defaults on the MAR Summary window. 

 
 

MAR Summary Window: Change Defaults 
 
 

25. Right click on the grey bar and select Change Defaults…  
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 The MAR Summary Defaults pop-up window displays. 
 

 
 

MAR Summary Defaults Pop-Up Window 

 

26. Make changes to Default Settings as desired.  

27. Click OK to save changes and close the pop-up window.  

 

MEDICATION LIST  

From the Chart menu, click Medication List. Multiple tasks can be performed within the Medication List window 
including: Add, Document Medication, Reconciliation, Check Interactions, and External Rx History. Any orders not 
entered by the provider must be co-signed. 
 

 

Medication List Window 
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 Add a Medication 

Note ► This functionality is used to place an order for a new medication. 

Note ► This section is for reference only. Pharmacists will not be 
responsible for adding diagnoses or medications for patients. 

1. From the Medication List window, click the add icon ( ). 
2. From the Add Order pop-up window, a medication can be added but there must first be a 

diagnosis or problem to associate with the medication. 

Note ► If the chart already contains diagnoses and problems, skip to step 
8. 

3. From the Diagnoses & Problems column on the left of the window, click Add. 

4. From the Add Diagnosis pop-up window, type a diagnosis and click the find icon ( ). 
5. From the Diagnosis Search pop-up window, additional search criteria can be added, or click on 

the diagnosis in the search results that needs to be saved. 
6. Click OK. 
7. From the Add Diagnosis pop-up window, click OK. Repeat steps 3-6 to add additional diagnoses 

or problems. 
8. Select the check box next to each diagnosis or problem that needs to be associated with the 

order that is being added. 
9. From the search bar, type the name of the medication then press Enter. 
10. From the search results, click the correct medication, inclusive of the dose that is being ordered, 

then click Done. 
11. For non-physicians who are ordering a medication, the Ordering Physician pop-up window 

displays. Type the ordering Physician’s name. The order date and time default to the current date 
and time. 

12. In the Communication Type field, select Phone, Verbal, Signature Required or Written 
(Paper)/Fax, then click OK. 

Note ► If a physician is adding the order, steps 11 and 12 are omitted. 
The Communication Type drives the need for co-signature.  

13. Type all details, comments and diagnoses for the order, including the Medication Indication. 
14. Click Sign. The medication now populates in the Medication List and has a Processing status until 

it is filled by the pharmacy. 

Note ► For a Physician, when an order needs to be signed Orders For 
Signature at the bottom of the window are enabled. 

Note ► For anyone other than a Physician, the Orders for Co-Signature 
button is enabled. 

Note ► For a Nurse, when an order needs to be reviewed, Orders For 
Nurse Review at the bottom of the window are enabled. 
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NOTES 

From the Chart menu click +Add next to Notes to access the Notes functionality. From this window, view, modify 
or add notes.  

 View Notes 
1. From the Notes window, view any Notes that have been added to a chart within the dates 

specified on the information bar along the top of the window. 
2. On the left side of the window, select the folder that contains the note that needs to be viewed. 

The note displays in the center of the window. 
3. Sort the clinical notes view by selecting a radio button: By type, By status, By date, Performed by 

or By encounter. 
4. Use the up and down arrow buttons to scroll up and down through the available notes. 

Note ► If the note does not display, the date range may need to be 
changed. Right click the information bar at the top of the Notes 
window where the date is displayed, and select Change Search 
Criteria. In the pop-up window, change the From and To dates, 
then click OK. 

 Add an Addendum to a Note 
1. From the Notes window, double click the note that needs to be modified. The note displays in 

the center of the window. 

2. Click the modify icon ( ). 

3. After required changes have been made, click the Sign Form icon ( ) in the top left of the 
window. 

4. A pop-up window displays and asks: A change has been made to the note details of the 
document. Would you like to save this change? 

5. Click Yes. 

Note ► After a note is modified, “Document Contains Addenda” will 
display at the top in red. 

 Add a Note 

1. From the Notes window, click the add icon ( ) to add a new note. 
2. From the Add Document pop-up window, select the type of note to add. 
3. Complete all fields on the window and type the note. 
4. Complete the note by: 

 Clicking Sign – Completes the documentation, and publishes the note to the resident’s 
chart 

 Clicking Save – Saves the note without signing it, but leaves the note window open; this 
provides the ability to make revisions at a later time. The status of the note will remain 
as In Progress until it’s closed 
 

Tip ► Even when temporarily walking away from the computer, it is important to always save a note to 
prevent data loss in the event of a power outage or network failure. 

 
 Clicking Save & Close – Saves and closes the note without signing it 
 Clicking Cancel - Closes the pop-up window without saving changes 
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All notes are marked with a colored square to indicate the status. When a note is opened, a yellow dot displays in 
the center of the colored square. Note statuses are as indicated in the chart below: 
 

 In Progress – The note is in progress, and has not yet been signed 

 Transcribed – The note has been typed, but not yet signed 

 Unauthenticated – The note has been signed, but by someone who is not authorized to provide final 
approval 

 
Authenticated – The note is finalized and signed 

 
Modified/Corrected – The note or document has been modified, and there is an addendum 

 
Anticipated – A record is anticipated, but has not yet been typed 

 Error – The note was typed in error 

 
Unknown Status 

 

 

Notes Window 
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RESIDENT INFORMATION 

From the Chart menu, click Resident Information to view resident demographics, the visit list, and the PPR 
summary. This is a view-only window, and information contained herein was typed during scheduling and 
registration. 
 

 

Resident Information Window 

 

MEDICAL RECORD REQUEST  

Medical Record Request (MRR) is a tool used to create an ad hoc patient chart through PowerChart. The most 
common report requested through MRR Document report. 

Requesting a Report 

1. From the Task menu select Print > Medical Record Request or the MRR tab at the top of the 
Powerchart 

Note ► You must be in a resident chart to do this. 

2. Complete the MRR dialogue box 
 Event Status – Verified Only 

 Template – Document(or whatever is applicable) 

 Purpose –Transfer (or whatever is applicable) 

 Date Range – Clinical Range  

 Section Select- Narrow down and choose you results to send/print here 

 Check that proper authorization was received 

 Input the proper Destination, Requester, and comments (if needed) 

 Select the desired Device to send the report – xrchartnull or example printer 

3. Send the request through MRR. 
4. “X” out of MRR.  
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Note ► The next time you open the MRR window, the same parameters 
will populate in the dialogue box for usability.  

Requesting a Single Document 

1. From the main menu select Notes (Clinical Notes, Documents, etc. will vary based on client), 
open the desired document to print. 

2. Select the print icon or right click the document you wish to choose. 
3. Click OK.  
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Additional Information 

 Resident Care Report Includes: 

o Patient Care items 

o Such as Iview, allergies, orders, etc. 

 Document Report Includes: 

o Clinical and Nursing Notes (Power Forms, things viewable in the Notes tab) 

 Tidbits: 

o Printing through MRR is trackable through Report request maintenance. Printing should 
be limited and generally for outside use.  

o Printing through MRR also allows for easier trouble shooting of any issues in report 
request maintenance. 

 

PRINTING 

Open a resident’s chart, then click the print icon ( ) at the top right of any window to print its contents. The 
print functionality does not display on every window. 

Note ► A provider may want to print a medication list, or document from 
the resident chart. 

 
Select Print Options Pop-up Window 

 

Note ► The Print option also allows a provider to send a portion of the 
resident chart.  
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NAVIGATION 

This section guides pharmacists through the basic navigation functionality that is specific to the pharmacy function.  
 

Objectives 

 Create and sort resident views 

 Find and view priority orders 

 View resident chart details 

Create a New View in Pharmacy Patient Monitor 

The Create/Edit view feature provides the option to create customized views in Pharmacy Patient Monitor. These 
views are linked to the user’s ID and display whenever that ID is used to log in to Cerner. 
 

1. Log in to PowerChart.  

 The Pharmacy Patient Monitor home window displays. 

 

 
Patient Pharmacy Monitor 

 

2. From the View drop-down menu, select the desired view.  

3. Click on the settings icon (  ) to create a new view. 

4. From the settings menu, select Create/Edit View. 
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 The Create/Edit View settings menu displays.  
 

 
 

Pharmacy Patient Monitor: Create/Edit View Preferences 
 

5. From the Select filters list, select the desired filter.  

6. Click Update. 

 The Location Filter View window displays. 

 
 

Pharmacy Patient Monitor: Location Filter View 
 

7. Mark the check boxes to make filter selections. 

8. Click OK. 
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 The Create/Edit View settings menu displays.  

 

 
Pharmacy Patient Monitor: Create/Edit View Preferences 

9. Click Save View As. 

 

 The Save View As window displays.  

  
 

Pharmacy Patient Monitor: Sort View 

 

10. Type the name of the view in the View Name field. 

11. Click Save. 
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 The new view title now displays in the View drop-down menu.  

 

Pharmacy Patient Monitor: View Drop-down Menu 

 

Sort View 

This process begins from the Pharmacy Patient Monitor window that displays after you log in. 

 

1. From the Pharmacy Patient Monitor window, click the sort icon ( ). 

2. From the sort menu, select the preferred sort option. 

Note ► The default view displays highest priority orders at the top. 
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 The view updates to reflect the selection. 

 
 

Pharmacy Patient Monitor: Sort View 

 

Perform a Resident Search 

This process begins from the Pharmacy Patient Monitor window that displays after you log in. 
 

 
 

Pharmacy Patient Monitor: Perform a Resident Search 
 

1. From the Name drop-down menu, select a search option.  

2. In the search field to the right of the magnifying glass icon (  ) type your search criteria. 

3. Press the Enter key on your keyboard. 
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View Priority Orders 

This process begins from the Pharmacy Patient Monitor window that displays after you log in. 
 

 
 

Pharmacy Patient Monitor: View Priority Orders 

 

1. Click the box with the number in it next to the View drop-down menu.  

Note ► The number in the orange box reflects the total number of 
pharmacy orders, including but not limited to the number of 
priority orders. 

 The Order Priority View window displays with the priority orders listed in order of those in 
the queue the longest.  

 

 
Pharmacy Patient Monitor: View Priority Orders 

 

2. Select a resident from the list. 

3. Click OK.   
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 The resident’s orders display under Inpatient Orders. 

 
 

Pharmacy Patient Monitor: Inpatient Orders 

View Resident Chart Detail 

 This process begins from the Pharmacy Patient Monitor window that displays after you log 
in to PowerChart. 

 
Pharmacy Patient Monitor: Resident’s Name 

 

1. Click on the resident’s name. 
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 The resident’s chart displays in a new window within PowerChart. 

 

Resident Chart Window 

Note ► Use the links in the chart Menu to view more information about 
the resident. 

 

Process Orders from PowerChart 

 Select the resident from the Pharmacy Patient Monitor window in PowerChart 

 
 

PowerChart: Pharmacy Patient Monitor 

 



 
 

 

IRIS Pharmacy Training Manual             44 

1. From the Pharmacy Patient Monitor window in PowerChart, select the resident from the list on the left.  

2. The resident’s orders to process display on the right of the window. Click Process to begin processing 
orders. 

Note ► Click View to go to the resident’s profile in Medication Manager. 

 

 Medication Manager opens in a new window.  

 
Medication Manager Window 

 

3. Click Apply to begin processing orders. Once the first order is processed, the next order will display for 
processing. 
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Interventions 

 Begin on the Acute Profile tab on the Pharmacy Patient Monitor window 

 
 

Pharmacy Patient Monitor window 
 

1. From the Pharmacy Patient Monitor window in PowerChart, select the resident from the list on the left 
and click Process. 

 

 The Acute Profile Tab on the Pharmacy Medication Manager window displays 

 
Pharmacy Medication Manager Window: Acute Profile Tab 

 

2. Click Apply. 



 
 

 

IRIS Pharmacy Training Manual             46 

Note ► Navigate to this window using the steps in the Process Orders 
from PowerChart lesson. 

 

 The Verify Med Order pop-up window displays. 

 

Verify Med Order Pop-Up Window 

3. Click Rx Intervention. 
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 The AdHoc Forms pop-up window displays. 

 
AdHoc Forms Pop-Up Window: Select Pharmacy Clinical Intervention 

 

4. Mark the check box next to Pharmacy Clinical Intervention. 

5. Click Chart. 

Note ► This can also be documented using AdHoc in the resident’s chart 
PowerChart to access the form. Click AdHoc, then select the form 
and click Chart. 
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 The Pharmacy Clinical Interventions form pop-up window displays. 

 
 

Pharmacy Clinical Interventions Form Pop-Up Window 
 

6. Select the intervention type from the options under Intervention Type. 

7. Select who initiated the intervention under Initiated By. 

8. Select the clinical importance under Clinical Importance. 

9. Select the intervention time under Pharmacist Intervention Time. 

10. Click the save icon ( ) to save the form. 

Note ► NOTE - Do not sign the form at this time. The form is signed after 
speaking with the prescriber.  
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 The AdHoc Forms pop-up window displays. 

 

AdHoc Forms Pop-Up Window: Click Close 

 

11. Click Close to close the AdHoc Forms pop-up window.  

 

 The Verify Med Order pop-up window displays.  

 
 

Verify Med Order Pop-Up Window 

12. Click OK. 
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 Navigate to the Consults and Interventions window.  

 
PowerChart: Consults and Interventions 

 

13. From PowerChart, click Consults and Interventions.  

14. To update and sign the Pharmacy Clinical Interventions form, double-click on the entry in the list.  

Note ► The time frame criteria may need to be adjusted for the entry to display. 

 

 The Pharmacy Clinical Interventions form pop-up window displays. 

 
Pharmacy Clinical Interventions Form Pop-Up Window 

 

15. Update the Prescriber Response field and any other applicable fields.  

16. Click the sign icon ( ) to sign and close the form. 
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Note ► The form can now be accessed through the Forms Browser band 
on the resident’s chart. 

 

 The Consults and Interventions window displays with a green check next to the signed 
entry.  

 
Consults and Interventions: Signed Form 

 

17. Click the refresh icon (  ). 

 

 The Consults and Interventions window refreshes.  

 
Consults and Interventions Window: Refreshed View 

 

18. The item no longer displays in the list. 

 

  



 
 

 

IRIS Pharmacy Training Manual             52 

Chart Consults  

 This process begins from the Pharmacy Patient Monitor window that displays after you log 
in to PowerChart. 

 
 

Pharmacy Patient Monitor Window 
 

1. From the Actions Toolbar, click Consults and Interventions. 

 

Note ► This window should be monitored throughout the day.  

 

 The Consults and Interventions window displays. 

 
 

Consults and Interventions Window 

 

2. For Consults, the Order Details field displays the type of consult requested.  

3. Perform the requested consult, then click the resident’s name to select the row.  

4. Click the sign icon ( ) to indicate that the consult is complete. 
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 The Consult to Pharmacy (Chart Done) pop-up window displays. 

 

 
 

Consult to Pharmacy (Chart Done) Pop-Up Window  
 

5. Click OK. 

Note ► Document on a Progress Note, as applicable.  

 

 A green check displays next to the completed consult. 

 

 
Consults and Interventions Window: Consult Complete Indicator 

 
 

6. A green check mark icon ( ) displays next to the completed consult. 

7. Click the refresh icon (  ). 
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 The Consults and Interventions window refreshes.  

 
 

Consults and Interventions Window: Refreshed 

 

8. The completed consult no longer displays. 

Consults and Interventions Task List Icons 

The following table is a list of the icons encountered in the Consults and Interventions window.  
 

 

Exercises 

1. Sort queue by Name. Next sort by queue time and then start date. 

2. Search for a resident with the last name of Train and record the number of results.  

3. Record how many priority orders are in the queue. 

4. Access your assigned resident's chart and record any reported allergies. 
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ADHOC CHARTING (FORMS) 

Quarterly Drug Regimen Review 

 Navigate to the AdHoc Charting pop-up window. 

 

 
 

Navigate to AdHoc Charting Pop-Up Window 
 

1. Click AdHoc. 

 

 The AdHoc Charting pop-up window displays. 

 

 
 

AdHoc Charting Pop-Up Window 

 

2. Click the Clinical Pharmacy folder. 

3. Mark the check box next to Quarterly Drug Regimen Review. 

4. Click Chart. 

Note ► After the first Quarterly Drug Regiment Review is created, the 
data entered will flow into the form that is created during the 
next review.  
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 The Quarterly Drug Regimen Review form pop-up window displays. 

 

Quarterly Drug Regimen Review Form Pop-Up Window 

 

5. Select the Type of Medication Review.  

6. Review the Current Medication List. 

7. Click the Clinical Findings band. 
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 The Clinical Findings band of the Quarterly Drug Regimen Review form displays. 

 

 

 

Quarterly Drug Regimen Review Form: Clinical Findings (continues below) 
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Quarterly Drug Regimen Review Form: Clinical Findings (continued) 
 
 

8. Complete all fields that apply. 

9. Click the Medication Regimen Review Findings band. 
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 The Medication Regimen Review Findings band of the Quarterly Drug Regimen Review form 
displays. 

 

 

Quarterly Drug Regimen Review Form: Medication Regimen Review Findings 

 

10. Make recommendations in the Recommendations to Physicians field. Click <MultiAlpha> to view 
selections.  

11. After all three bands of the form are complete, click the sign form icon ( ) to sign the form. 
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 Navigate to the Notes window. 

 

 

Notes Window 

 

12. Click Notes on the chart Menu. 

13. Expand the PowerForms Textual Rendition Notes folder. 

Note ► The PowerForms Textual Rendition Notes folder is only visible 
when sorting Notes by type.  

14. Expand the Pharmacy Forms – Text folder. 

15. Right-click on the form to forward. 

16. Select Forward document from the drop-down menu. 

 

 The Forward Only: Documents pop-up window displays.  

 
Forward Only: Documents Pop-Up Window 

 

17. Select Sign from the Additional Forward Actions drop-down menu. 

18. Click the binoculars icon ( ) to select recipients. 
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 The Address Book pop-up window displays.  

 
 

Address Book Pop-Up Menu 

 

19. Select recipients from the Names list. 

20. Click Add to add the recipients to the Send to list. 

21. Click OK. 

 

 The Forward Only: Documents pop-up window displays.  

 
Forward Only: Documents Pop-Up Window 

 

 

22. The recipients display in the To field. 

23. Type in the Comments field, if applicable.  

24. Click OK to send the form for signature. 

Note ► After the form is signed, it is accessed through Form Browser. 
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Chemical Post-Restraint Review  

When Restraint Crisis Intervention Chemical order set is initiated, a task to complete the Chemical Post-Restraint 
Review form displays in Consults and Interventions.  

 

 The Consults and Interventions window displays. 

 
Consults and Interventions Window 

 

1. From the Actions Toolbar, click Consults and Interventions. 

2. Double-click on a Chemical Post-Restraint Review entry. 
 

 The Chemical Post-Restraint Review form pop-up window displays. 

 

Chemical Post Restraint Review Form Pop-Up Window 
 

3. Complete the Pharmacist Review fields. 

4. After the form is complete, click the sign form icon ( ) to sign the form. 
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MEDICATION ORDER ENTRY 

In this section, you will learn the functionality to review resident medication profiles and process new medication 
orders. 
 

Objectives 

 Review medication profiles for residents 

 Add a new medication 

 Process alerts and perform overrides 

 

View Clinical Notes in Medication Manager 

 Navigate to the Clinical Notes pop-up window from Medication Manager. 

 

 
Medication Manager 

1. From Medication Manager, click the Rx Clinical Note icon ( ) 
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 The Clinical Notes pop-up window displays. 

 

 
 

Clinical Notes Pop-Up Window 

 

2. Use the folders on the left to navigate the clinical notes. Double-click the note to view the note on the 
right side of the window.  
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Review Resident Medication Profile 

1. From the Pharmacy Patient Monitor window, click the resident’s name. 

 

 Orders for the resident display in the Inpatient Orders area.  

  

 
Pharmacy Patient Monitor: Inpatient Orders 

 

2. Click View under the resident’s information.  

 

 Pharmacy Medication Manager opens in a new window to display the resident’s Acute 
Profile. This tab displays medications that are filled using Medication Manager to be 
administered to the resident within the facility. 

 

Pharmacy Medication Manager: Acute Profile 
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3. Click the Ambulatory Profile tab at the top of the window to view the resident’s ambulatory medication 
profile. This tab displays medications that are filled through Pharmacy Medication Manager Retail as 
prescriptions for residents who plan to be outside the facility for a period of time.  

Note ► This is for reference only in Pharmacy Medication Manager. Use 
Medication Manager Retail to take action on these items. 

 

Address Alerts  

 If a resident has a known dietary restriction that could impact the fulfillment of the 
prescription, a Discern alert pop-up window displays after you select the resident.  

 
 

Discern Alert Pop-up Window 

1. Click OK to acknowledge and dismiss the alert.  

 

 If the ordered medication could cause danger to the resident, such as an interaction with 
another medication, the Medication Clinical Decision Support (mCDS) pop-up window 
displays at the beginning of the process with an alert dialogue message.   

Note ► The window displays separate categories of alerts: Allergy, 
Drug/Drug, and Duplicate Therapy. The category or categories 
that pertain to that specific alert will have additional information 
in the respective section.  
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Medication Clinical Decision Support (mCDS) 

 

2. To avoid verifying the action, click Stop Verify Action on the bottom of the window. The order status 
remains unverified. 
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 If a resident’s height, weight or creatinine level is missing, a Discern alert pop-up window.  

 
 

Discern Alert Pop-Up Window 
 

3. To cancel the transaction until you have the appropriate data, click Cancel. 

4. Click OK. 
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 The Medication Manager window displays again. 

 
 

Medication Manager Window. 
 

5. Click in the Demographics area on the left of the window.  

 

 The Demographics pop-up window displays. 

 
Demographics Pop-Up Window 

 

6. Update the appropriate information. 

7. Click Submit.  
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 The Medication Manager window displays the updated information. 

 
 

Medication Manager Window: Updated 

 

8. The updated information displays.  
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Select Product and Dosage  

Note ► A stacked formulary indicates all National Drug Codes (NDCs) are 
added under one database entry that represents a generic 
formulation of a drug. A stacked formulary is the opposite of an 
‘un-stacked’ formulary where there is a database entry for every 
NDC.  

 Begin at the Medication Manager window 

 

Pharmacy Patient Monitor: Inpatient Orders Window 
 

1. Enter the medication name in the Drug field at the top of the Acute Profile window in Pharmacy 
Medication Manager. 

2. Click Add. 
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 The Product Search pop-up window displays with a list of potential search matches. 

 

Product Search Pop-Up Window 

Note ► Use the additional search features to narrow the search.  

3. Select the row with the desired drug, dosage and form. 

4. Click OK. 
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 The New Med Order pop-up window displays.  

   

New Med Order Pop-Up Window 

Note ► The yellow highlighted fields are required fields to complete.   

5. Click Update to type information into the fields on the window. Most fields are populated based upon the 
product requested and can be updated in the pop-up window if necessary. The following fields require 
input from the pharmacist. 

6. Frequency – how often the mediation is to be administered 

Note ► Pharmacy Medication Manager does not allow users to build 
custom frequencies; however, users can customize the times on 
an existing frequency.  

7. Physician – the name of the provider requesting the order 

8. Start Date – the date and time to begin the first dose 

9. Communication type – method of communication used by the provider to request the order. 

10. Dispense category – how the medication is dispensed such as BULK 

11. Click Comments to provide additional details regarding the prescription.  
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Note ► Order Comments and Product Notes print on the label and display 
in Order History.  

 The Comments pop-up window displays.  

  

Comments Pop-Up Window 

12. Type the indication in the Medication Indication field. 

13. Select No or Yes from the Through MMR drop-down menu and type information in other fields if needed.  

Note ► Rx Comments are only visible within Medication Manager and 
cannot be viewed in any other application. Anything typed in the 
Fill Notes field will be printed on the fill list. 

14. Click OK to close the Comments pop-up window. 
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 The New Med Order window displays. 

  

 

New Med Order 

 

15. Mark the check boxes on the bottom left of the New Med Order window to indicate if this is the 
resident’s own medication (from home) and/or if the initial dose should be auto calculated. 

16. Verify Dispense Category, Dispense Location and Initial Doses.  

17. Click OK. The New Med Order window closes.  
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 The Pharmacy Medication Manager window displays. 

 

 

Pharmacy Medication Manager 

 

18. From the Pharmacy Medication Manager, click Submit to submit the order. After the order is submitted, 
the label will print. 
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Perform Overrides 

 The Medication Clinical Decision Support (mCDS) pop-up window 

 

Medication Clinical Decision Support (mCDS): Overrides 

 

1. If an override is warranted for an alert based on medical necessity as decided by the pharmacist, from the 
Medication Clinical Decision Support (mCDS) pop-up window, select the reason from the Reason drop-
down menu for each potential issue.  

Note ► Any previous overrides will be noted above the Reason drop-
down menu for the current override entry.   

2. If more than one potential interaction is indicated, one of the following radio buttons must be selected at 
the bottom of the window: Apply to all interactions, Apply only to required interactions, or Apply only 
to selected.  

3. Select the Override Reason. 

4. Click Continue or Remove New Order.  

Note ► Remove New Order triggers the Consults and Interventions 
workflow. 
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 The New Med Order window displays.  

 

5. Continue the process as outlined in steps 4 through 9 of the Conduct Product Verification lesson to 
complete entering the order.  

Note ► Click Alert History… to see prior alerts.  

Exercises 

1. View your assigned resident's Medication profile and enter an order for Benadryl. 

2. Enter an order for Tegretol, address any alerts that display. 
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PHARMACIST VERIFICATION 

This section describes the process to verify pharmacy orders.  
 

Objectives 

 Modify orders 

 Verify products 

 Complete reviews 

 Process medication from the resident’s own supply 

 

Conduct Product Verification 

 Use the list in Pharmacy Patient Monitor to begin the verification process.  

 

 
Pharmacy Patient Monitor window 

 

1. Select a resident from the list and click Process.  
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 The Pharmacy Medication Manager window displays. 

 

Pharmacy Medication Manager: Acute Profile 
 

2. The Action column displays Verify in the drop-down menu next to the medication. 

3. Click Apply. 

 

Note ► Click Apply to begin the process. This does not submit the order 
for distribution in the system. 

  



 
 

 

IRIS Pharmacy Training Manual 81 

 The Verify Med Order pop-up window displays.  

 
 

Verify Med Order Pop-Up Window 
 

4. Verify that the information on the window is correct.  

Note ► Please reference the Select Product and Dosage documentation in 
the Medication Order Entry segment of this document for further 
clarification regarding this window. 

 

5. Click Comments.  

Note ► Any instructions regarding sliding scale insulin orders will display 
in the Order Comments field on the Verify Med Order pop-up 
window. 
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 The Comments pop-up window displays.  
 

 
 

Comments Pop-Up Window 
 

6. Complete the required fields as indicated by the red asterisk (*), and any other applicable fields. 

7. Click OK to save the comments and close the Comments pop-up window.  
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 The Verify Med Order pop-up window displays. 

 
 

Verify Med Order Pop-Up Window 
 

8. Click OK on the Verify Med Order pop-up window.  

Note ► To Reject an order click Reject at the bottom of this screen. The 

Pharmacist Rejected Order icon ( ) displays on the Acute Profile 
window. The resident’s MAR will also reflect that the order was 
rejected.  
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 The Pharmacy Medication Manager Acute Profile window displays.  

 
 

Pharmacy Medication Manager: Acute Profile 
 

9. Click Submit to complete the verification process. After clicking Submit, the label will print. 

 

Note ► The chevrons next to the Status column indicate that the order 
has been updated but not yet submitted. Click Submit to submit 
the order for distribution. 
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Complete Clinical and Dispensing Reviews 

 Navigate to Discern Analytics 2.0 from the Actions Toolbar in Powerchart 

 
 

PowerChart: Navigate to Discern Analytics 2.0 
 

1. From PowerChart, click Discern Analytics 2.0 on the Actions Toolbar. 

 

 The Select Organizations pop-up window displays. 

 

 
 

Select Organizations Pop-Up Window 

 

2. Select the organization from the Select Organizations pop-up window. 

3. Click Select. 
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 The Discern Analytics 2.0 window displays. 

  
 

Discern Analytics 2.0 Window 

 

4. Click the folders on the left pane to expand them and see more options. 

 

 The expanded folders display. 

 
 

Discern Analytics 2.0 Window: Navigate to Report 

 

5. Double-click the desired report. 
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 The Discern Prompt pop-up window displays. 

 
 

Discern Prompt Pop-Up Window 
 

6. Enter the report parameters in the fields provided. 

Note ► This window will vary based upon the report requested.   

7. Click Execute.   

 The report displays on the right side of the Discern Analytics 2.0 window. 

  
 

Discern Analytics 2.0 Window   

 

8. The report displays on the right side of the Discern Analytics 2.0 window. Use the icons above the report 
content to print or save the report.  
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Verify Patient’s Own Supply  

 From the Pharmacy Med Manager window, navigate to the Acute Profile tab. 

 
 

Pharmacy Med Manager 
 

1. From Action drop-down menu for the selected medication, select Verify. 

2. Click Apply. 
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 The Verify Med Order pop-up window displays.  

 

 

 
Verify Med Order Pop-Up Window 

 

3. Verify that the information on the window is correct.  

4. Click Comments.  
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 The Comments pop-up window displays.  

 

  
 

Comments Pop-Up Window 
 

5. Complete the required fields that are indicated by the red asterisk (*). 

6. Complete any other applicable fields. 

7. Click OK.  
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 The Verify Med Order pop-up window displays.  

 

 
 

Verify Med Order Pop-Up Window 
 

8. Verify that all required fields indicated by the red asterisk (*) are complete. 

9. Verify that the Patient’s own med check box is selected. 

10. Click OK. 
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 The Resident’s Own Medication alert window displays.  

  

Resident’s Own Medication Alert 
 

11. Select the appropriate Alert Action. 

12. Click OK.  

 The Pharmacy Med Manager window displays. 

 
 

Pharmacy Med Manager: Acute Profile 
 

13. Click Submit on the Acute Profile window.  
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PHARMACY DISPENSING 

Fill Prescriptions for Resident Furlough  

 Navigate to PharmNet: Retail Medication Manager. 

 
Navigate to PharmNet: Retail Medication Manager  

 

1. Click the Medication Manager Retail icon (  ) on the Appbar to access PharmNet: Retail Medication 
Manager. 

 

 The PharmNet: Retail Medication Manager window displays. 

 
 

PharmNet: Retail Medication Manager 
 



 
 

 

IRIS Pharmacy Training Manual             94 

Tip ► The PharmNet Pharmacy Medication Manager and PharmNet: Retail Medication Manager windows 
are very similar. To help easily differentiate between the two, add a Focus tracker. To do this, click on 
Options in the Menu Toolbar and select User Preferences from the drop-down menu. Then click the 
Application tab from the User Preferences pop-up window that displays. (There are many tabs so it 
may be necessary to use the scroll arrows next to the tabs to navigate to the correct one.) Mark the 
checkbox next to Focus tracker. Now the retail window will have a highlight box on it, making it easier 
to determine which application you are using.  

 

2. Use the search drop-down menu to select a search type and enter the search criteria in the field provided, 
then press enter on your keyboard to start the search. 

 

 The Person Search pop-up window displays a list of results.  

 

 
 

Person Search Pop-Up Window 

 

3. Select the resident from the Name list. 

4. Select the encounter from the FIN NBR list. 

5. Click OK. 
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 The Ambulatory Profile window displays. 

 

 
 

Ambulatory Profile Window 

 

6. From the Action drop-down, select Refill. 

7. Click Apply. 

 

 Product Selection pop-up window displays 

 
 

Product Selection Pop-Up Window 

8. Select the product from the list. 

Note ► This selection is NDC specific. “P” indicates the primary NDC 
currently active at the facility.  

9. Click OK. 
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 Retail Order for Patient pop-up window displays 

 

 
 

Retail Order for Patient Pop-Up Window 

 

10. Verify data in the Retail Order for Patient window and complete any required fields. 

Note ► Click View Rx to view the original prescription.  

11. Click OK. 
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 The Ambulatory Profile window displays 

 
 

 
 

Ambulatory Profile Window 

 

12. Click Submit. 

13. Medication displays with a valid Rx Number. 

 

Note ► Retail orders must be updated to reflect current NDC in stock. 

 

Print Label for Medication Request (Includes Shorts and Bulk Meds) 

Note ► To enter a Medication Request, the nurse right clicks on the 
medication in the MAR and selects Med Request… from the pop-
up menu. The Medication Request pop-up window displays. The 
nurse selects the reason from the Reason drop-down menu, 
provides comments in the comment field if applicable, and clicks 
OK.  

 

1. From Pharmacy Med Manager window, navigate to the Acute Profile tab.  
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Pharmacy Med Manager 
 

2. From the Action drop-down menu next to the selected medication, select Label. 

3. Click Apply. 
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 The Label Request pop-up window displays. 

   

Label Request 
 

4. In the Type of Label Request section, select the radio button for Extra dose/refill. 

5. From the Reason for label request drop-down menu, select the reason. 

6. Verify that the Charge patient box is not checked. 

7. Verify that the Dispense from location field contains correct information. 

8. From the Printer drop-down menu, select a printer. 

9. Click OK to print the label. 
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Label Example 

 

 

Exercises 

1. Verify your resident's order for Benadryl. 

2. Perform a review. 

3. Verify a medication from the resident's own supply. 
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APPBAR 

This section discusses the process for ordering products from external resources.  
 

Objectives 

 Access requisition system 

 Enter new requisitions 

 Verify existing requisitions 

 

Open Appbar  

 Navigate to the Appbar. 

 
 
 

Navigate to the Appbar 

1. Double-click the Appbar icon (  ). 
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 The Appbar displays. 
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Customize the Appbar 

 When the Appbar is open. 

 

 

Appbar 
 

1. Click the Appbar icon at the top of the bar. 

2. Select Customize from the pop-up menu that displays.  
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 The Customize Cerner AppBar pop-up window displays. 

 

 

 

Customize Cerner AppBar Pop-Up Window 

 

3. Make changes on the Options tab if desired.  

4. Click the Buttons tab. 
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 The Customize Cerner AppBar pop-up window displays. 

 

 

 

Customize Cerner AppBar Pop-Up Window 

 

 

5. Select which applications to add to the Appbar.  

6. Click OK.   
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Appbar Icon Key 

 

Icon Application 

 
Appbar 

 
Batch Dispensing 

 
Batch Report 

 
Charge/Credit 

 
DB Item Location Maintenance 

 
Distribution Manager 

 
Item Inquire 

 
Med Manager 

 
Medication Manager Retail 

 
Purchasing 

 
Receiving 

 
Recommended Order List 

 
Refill Work Queue 

 
Requisition 

 
Transaction Audit Browser 

 
Invoice Matching 

 
Physical Count 
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Batch Dispensing 

The Batch Dispensing process is created by an operations job that automatically runs based upon information 
gathered at time of design. Updates must be requested to the support teams. This section is for reference only. 
  

 Use the Appbar to access the Batch Dispensing application. 

 

 
Appbar 

 

1. Click Batch Dispensing icon (  ). 
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 The PharmNet: Batch Dispense pop-up window displays. 

 

PharmNet: Batch Dispense Pop-Up Window 

 

2. Select a batch from the Batch drop-down menu. 
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 The PharmNet: Batch Dispense pop-up window refreshes and additional fields are active. 

 
PharmNet: Batch Dispense Pop-Up Window 

 

3. Enter a date range in the Fill orders due field.  

Note ► If applicable, the From field defaults to the next possible date for 
the requested batch run. 

4. In the Dispense fields, type the number of minutes, hours, days, weeks, or months of doses to dispense 
and select the time measure from the drop-down menu. 

5. In the Output Options fields, select the Type of output, along with the Format and Printer to use. 

6. Click Run. 

 

 The PhaBatchDispense confirmation pop-up window displays. 

 
 

PhaBatchDispense Pop-Up Window  
 

7. Click OK. 
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 Fill List example 

 
 

 
 

Fill List example 
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Batch Report 

 Use the Appbar to access the Batch Report application 

 

 
Appbar 

 

1. Click Batch Report icon (  ). 
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 The PharmNet: Batch Report window displays. 

 
 

PharmNet: Batch Report Window 

 

2. Select a report from the Batch Reports list. 
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 The window refreshes and displays a Batch Name, with additional fields active.  

 

 
 

PharmNet: Batch Report Window: Select Batch Type 

 
 

3. Select a batch type from the Batch Type drop-down menu. 

 



 
 

 

IRIS Pharmacy Training Manual             114 

 Additional fields are active and/or required based upon the batch type selected. 

 
 

PharmNet: Batch Report Window: Additional Fields 
 

4. Complete fields as applicable to the desired report. 

5. Click Run. 

 

 The Report Run confirmation pop-up window displays. 

 

 
 

Report Run Confirmation Pop-Up Window 

6. Click OK. 
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Transaction Audit Browser 

 Use the Appbar to access the Transaction Audit Browser application 

 

 
Appbar 

 

1. Click the Transaction Audit Browser icon (  ). 
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 The Multiple Location Views Found pop-up window displays. 

 
 

 
Multiple Location Views Found Pop-Up Window 

 

2. Select a location view. 

3. Click OK.  

 

 The Materials Mgmt: Transaction Audit Browser window displays. 

 

 
 

Materials Mgmt: Transaction Audit Browser Window 

 

4. Enter the criteria in the window. 

5. Click Find Now. 
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 The transactions display below on the Materials Mgmt: Transaction Audit Browser window 

 

 
Materials Mgmt: Transaction Audit Browser Window with Transactions Displayed 

 

6. To view transaction detail, click on a transaction to select it. 

7. Click Details… 
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 The Inventory Transaction Audit Detail pop-up window displays. 

 
 

The Inventory Transaction Audit Detail pop-up window displays. 

 

8. Click the Close to close the pop-up window. 
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 The Materials Mgmt: Transaction Audit Browser pop-up window displays. 

 
 

Materials Mgmt: Transaction Audit Browser Window 

 

9. To view encounter detail, click on a transaction to select it. 

10. Click Encounter Details. 
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 The Patient Demographics pop-up window displays. 

 

 
 

Patient Demographics Pop-Up Window 

 

11. Click the tabs to view more information. 

12. Click Close to close the pop-up window. 
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Charge/Credit  

 Use the Appbar to access the Charge/Credit application. 

 

 
 

Appbar 

 

1. Click the Charge/Credit icon (  ). 

 

Note ► Another method of accessing this application is to click 
Charge/Credit Entry on the Resident Toolbar in Powerchart. 
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 The PharmNet: Charge/Credit window displays. 

 
 

PharmNet: Charge/Credit Window 
 

2. Enter the resident’s MRN in the Enter a patient MRN field. Complete any other relevant fields and then 
press the Enter key on your keyboard. 

Note ► Medication is charged upon administration.  

 

 The window refreshes to display the search results. 

 

 
 

PharmNet: Charge/Credit Window 

 

3. Click once in the +/- column to add a charge. A charge is indicated by a plus sign (+). Click twice to add a 
credit. A credit is indicated by a minus sign (-). Continue this process for all impacted orders.  
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 The Service Date field populates with the current date and the Doses field is now 0.  

 
PharmNet: Charge/Credit Window 

 

4. Update the Service Date, if necessary. 

5. Type the number of doses in the Dose column. 

6. To view the Service Date Validation pop-up window, click the glasses icon (  ). 

 

 The Service Date Validation pop-up window displays. 

 

 
Service Date Validation Pop-Up Window 

 

7. View the information on the screen, then click Close. 
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 The PharmNet: Charge/Credit window displays.  

 

 
 

PharmNet: Charge/Credit Window 
 

8. Click Submit to submit the charges and/or credits.  

 

 The PharmNet: Charge/Credit window refreshes with Total Doses and Total Quantity fields 
update to reflect the doses entered. 

 
 

PharmNet: Charge/Credit Window: Total Doses and Total Quantity Updated 

 

9. Click the Add New Charge icon ( ) to add a new charge. 
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 The Product Search pop-up window displays. 

 

 
 

Product Search Pop-Up Window 

 

10. Type the product name in the Search field. 

11. Click Search. 

12. Select the product from the list that displays. 

13. Click OK. 

 

 The Charge – New Order pop-up window displays. 

 
 

Charge – New Order Pop-Up Window 
 

14. Complete the required fields. 

15. Click OK 
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 The Add New Charge – Completed pop-up window displays. 

 

 

 

Add New Charge – Completed Pop-Up Window 

 

16. Click No. 

 
 

 The PharmNet: Charge/Credit window displays the additional product. 

 
 

PharmNet: Charge/Credit Window 

 

17. Click Submit.  
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 The PharmNet: Charge/Credit window refreshes with Total Doses and Total Quantity fields 
update to reflect the doses entered. 

 
 

PharmNet: Charge/Credit Window: Total Doses and Total Quantity Updated 

 
 

DB Item Location Maintenance 

 Use the Appbar to access the DB Item Location Maintenance application. 

 

 
 

Appbar 
 

1. Click the DB Item Location Maintenance icon (  ). 



 
 

 

IRIS Pharmacy Training Manual             128 

 

 The DB Item Location Maintenance window displays. 

 

 
DB Item Location Maintenance Window 

 

2. Click on the plus sign (+) next to an Inventory Location to view more options. Continue to click the plus 
signs (+) to navigate to the desired locations. 
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 The inventory for the selected location displays. 

 

 

DB Item Location Maintenance Window 
 
 

3. Click the desired Description. 

4. The Item Control information displays at the bottom of the window. 

5. Click the Acquirement Properties tab. 
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 The Acquirement Properties information displays at the bottom of the window. 

 

DB Item Location Maintenance Window: Acquirement Properties 
 

6. Click the Quantity Requirements tab. 
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 The Quantity Requirements information displays at the bottom of the window. 

 

 
 

DB Item Location Maintenance Window: Quantity Requirements 
 

7. Click the Stored Location tab. 
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 The Stored Location information displays at the bottom of the window. 

 
 

DB Item Location Maintenance Window: Stored Location 
 

8. Click the Quantity on Hand tab. 

 



 
 

 

IRIS Pharmacy Training Manual 133 

 The Quantity on Hand information displays at the bottom of the window. 

 
 

DB Item Location Maintenance Window: Quantity on Hand 
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Requisition 

 Use the Appbar to access the Requisition application. 

 

 
Appbar 

 

1. Click the Requisition icon (  ). 

 

 The Multiple Locations View Found pop-up window displays. 

  

Multiple Location Views Found Pop-Up Window 

 

2. Select the desired location view. 

3. Click OK. 
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 The New Requisition window displays. 

 

 
 

New Requisition Window 
 

4. Click the New Requisition icon ( ). 

5. Select your Requesting location. 

6. In the Item number field, type your Item number. 

Note ► If the item number is unknown, click the ellipses ( ) to search for 
the product by name. 

7. In the Requested quantity field, enter quantity. 

8. Click the Save Requisition icon ( ).  
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 The Requisition: Modify Requisition window displays. 

 
 

Requisition: Modify Requisition 

 

9. Click the Order Inquiry icon ( ) to view requisition progress details. 
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Distribution Manager 

 Use the Appbar to access the Distribution Manager application. 

 

 
 

Appbar 

 

1. Click the Distribution Manager icon (  ). 

 

 The Multiple Location Views pop-up window displays. 

 
 

Multiple Location Views Pop-Up Window 

 

2. Select a location. 

3. Click OK. 
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 The [Not Saved] Distribution Manager window displays. 

 

 
 

[Not Saved] Distribution Manager Window 
 

4. Click the New Transfer icon (  ) to create a new transfer. 
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 The [Not Saved] Distribution Manager window refreshes with the Distribution ticket and 
Requisition Numbers fields pre-populated. 

 

[Not Saved] Distribution Manager Window 
 

5. Complete the form.  
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 The form is complete. 

 

[Not Saved] Distribution Manager Window 
 

6. Click the Add to Line Items icon (  ). 
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 The new transfer displays as a line item. 

 

 

[Not Saved] Distribution Manager Window 

 

7. After all line items are entered, click the Commit icon (  ) to commit the form. 
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 The [COMMITTED] Distribution Manager window displays.  

 
 
 

[COMMITTED] Distribution Manager Window 

 

8. To search for an existing distribution record, click the Open Transfer icon (  ). 
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 The [Not Saved] Distribution Manager window displays. 

 

 
 

[Not Saved] Distribution Manager Window 

 

9. Type the distribution ticket number in the Distribution ticket field, then press the Enter key on your 
keyboard.  

Note ► If the Distribution ticket number is unknown, click the ellipses 
next to the Distribution ticket field to open a search pop-up 
window. 
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 The desired distribution ticket displays.  

 
 

[COMMITTED] Distribution Manager Window 
 

Note ► The window is titled [COMMITTED] Distribution Manager 
because this existing distribution ticket has already been 
committed. 
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Item Inquire 

 

 Use the Appbar to access the Item Inquire application. 

 

 
 

Appbar 

 

1. Click the Item Inquire icon (  ). 

 

 The Multiple Location Views pop-up window displays. 

 

 
 

Multiple Location Views Pop-Up Window 

 

2. Select a location. 

3. Click OK. 
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 The Materials Mgmt: Item Inquire window displays. 

 

 
 

Materials Management Item Inquire Window 

 

4. To view items by location, use the plus signs under Select a location to drill down and navigate to a 
specific location. Click on the selected location for the items to display. 

5. Click the Item tab to search by item. 
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 The Item tab of the Materials Mgmt: Item Inquire window displays. 

 
 

Materials Management Item Inquire Window: Item Tab 
 

6. Type search criteria in the Select an item field. 

 

 The Find: All Items pop-up window displays.  

 
 

Find: All Items Pop-Up Window 

 

7. Select the item from the list that displays. 
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Note ► The Cerner Item Number will not match the Morris & Dickson 
item number.   

8. Click OK. 

 

 The selected item information displays in the Materials Mgmt: Item Inquire window. 

 

 

Materials Management Item Inquire Window: Item Tab 
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Purchasing 

 Use the Appbar to access the Purchasing application. 

 

 
 

Appbar 

 

1. Click the Purchasing icon (  ). 

 

 The Multiple Location Views pop-up window displays. 

 

 
 

Multiple Location Views Pop-Up Window 

 

2. Select a location. 

3. Click OK. 
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 The Material Mgmt: Purchasing window displays. 

 

 
 

Material Mgmt: Purchasing Window 

 

4. To begin a new purchase order, click the Create Manual Purchase Order icon ( ). 
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 The Material Mgmt: Purchasing window refreshes to enable new purchase order entry.  

 
 

Material Mgmt: Purchasing Window 

 

5. Click the ellipses next to the Vendor Name field to search for a vendor. 
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 The Find: All Vendors pop-up window displays. 

 

 
 

Find: All Vendors Pop-Up Window 

 

6. Enter the search criteria in the fields on the pop-up window. 

7. Click Find Now to display results. 

8. Select the vendor from the list of search results. 

9. Click OK. 
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 The Material Mgmt: Purchasing window displays with the selected vendor populated in the 
Vendor Name field. 

 

 
 

Material Mgmt: Purchasing Window 

 

10. Select a location from the Deliver to Location drop-down menu. 

11. Click the Item Help icon ( ) to add the item. 
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 The Find: All Items pop-up window displays 

 

 
 

Find: All Items Pop-Up Window 
 

12. Enter the search criteria. 

13. Click Find Now. 

14. Select an item from the results that display. 

15. Click OK. 
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 The Material Mgmt: Purchasing window displays. 

 

 
 

Material Mgmt: Purchasing Window 

 

16. Double-click the cell to enter the quantity in the Quantity field. 

17. Click the Commit Current PO icon (  ). 

 The following pop-up window displays.  

 

 

 

18. Click OK.  

19. The PO is committed and will submitted with next operations job, which is run twice daily.  For immediate 
orders, contact the support team to expedite the PO.  

 

Tip ► To search for an existing purchase order, type the purchase order number in the PO Number field, 
then click enter on your keyboard. 
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Recommended Order List 

Note ►  This process is typically not required because the batch order 
process will manage medications that fall below a certain 
threshold.  

 

 Use the Appbar to access the Recommended Order List application. 

 

 
Appbar 

 

1. Click the Recommended Order List icon (  ). 

 

 The Multiple Location Views Found pop-up window displays. 

 

 
 

Multiple Location Views Found pop-up window 
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2. Select a location profile. 

3. Click OK. 

 

 The Recommended Order List window displays. 

 
Recommended Order List Window 

 

4. Click the Load ROL Template icon (  ) to select a template.  

 

 The ROL Template(s) pop-up window displays. 

 
 

ROL Template(s) Pop-Up Window 

 

5. Select a template from the list. 
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6. Click Load. 

 

 The Recommended Order List window displays. 

 

 

Recommended Order List Window 

7. Complete the remaining fields on this window as appropriate. 

8. Click Process Data. 

 

  The following pop-up window displays. 

 

 

9. Click OK.  
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Note ► If you intend to include internally sourced items, click Cancel, 
modify the fields as needed, and click Process Data again. Click OK 
in the pop-up window that follows.  

 

  The following pop-up window displays. 

 

 

 

10. Click OK.  

 

Tip ► The Recommended Order List can be modified and then submitted and turned into a PO.  
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Receiving 

 Use the Appbar to access the Receiving application. 

 

 
Appbar 

 

1. Click the Receiving icon (  ). 

 

 The Multiple Location Views Found pop-up window displays. 

 

 
 

Multiple Location Views Found Pop-Up Window 
 

2. Select a location profile. 

3. Click OK. 
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 The Select Receiving Profile pop-up window displays.  

 

 
 

Select Receiving Profile Pop-Up Window 

 

4. Select a profile from the Receiving profiles drop-down menu. 

5. Click OK.  

 

 The Materials Mgmt: Receiving window displays. 

 

 
 

Materials Mgmt: Receiving Window 
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6. Click the Create New Receipt icon (  ) to create a new receipt. 

 

 The Materials Mgmt: Receiving *** NEW RECEIPT*** pop-up window displays. 

 

 
 

Materials Mgmt: Receiving *** NEW RECEIPT*** Pop-Up Window 

 

7. Enter the PO number in the PO number field, then press the enter key on your keyboard. 
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 The updated Materials Mgmt: Receiving *** NEW RECEIPT*** pop-up window displays. 

 

 
 

Materials Mgmt: Receiving *** NEW RECEIPT*** Pop-Up Window 
 

8. Verify that the information is correct, then click the Commit Receipt icon (  ).  

Note ► If there is a short or the wrong item was delivered, a correction is 
required. 

 

 The Save Dialog pop-up window displays. 

 

 
 

Save Dialog Pop-Up Window 

 

9. Click Yes. 

10. The receipt is committed.  

 

Tip ► To view prior receipts, click the folder icon (  ) and then enter the PO number in the PO number 
field. Press enter on your keyboard and the receipt displays. 
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Invoice Matching 

 Use the Appbar to access the Invoice Matching application. 

 

Appbar 
 

1. Click the Invoice Matching icon (  ). 

 

 The Select Invoicing Profile pop-up window displays. 

 

 
 

Select Invoicing Profile Pop-Up Window 
 

2. Select a profile from the Invoicing profiles drop-down menu. 
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 The Invoice Matching window displays. 

 
 

Invoice Matching Window 

 

3. Click the New Invoice icon (  ) to begin a new match. 
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 The Invoice Matching window refreshes. 

 
 

Invoice Matching Window 

 

4. Type the PO number in the PO number field. Press the Enter key on your keyboard.  
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 The Invoice Matching window refreshes to display PO information. 

 

 
Invoice Matching Window 

 

5. Make a selection from the Header Status drop-down menu. 

6. Type the invoice number in the Invoice number field. 

7. Click the Invoice Details Tab. 

 



 
 

 

IRIS Pharmacy Training Manual             168 

 The Invoice Details window displays.  

 

 

8. In the receipt window, mark the check-box next to the receipt requiring an invoice. 

9. In the voucher-line(s) window, mark the check-box next to the items requiring an invoice. 

10. Return to the Invoice Header tab.  
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 The Invoice Header window displays.  

 

 

11. Enter the Invoice total. Note: the invoice total should match the total voucher amount to avoid an 
outstanding balance.  

12. Enter Click the Save icon (  ).  
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Physical Count 

 Use the Appbar to access the Physical Count application. 

 

 
Appbar 

 

1. Click the Physical Count icon (  ). 

 

 The Multiple Location Views Found pop-up window displays. 

 
 

 
Multiple Location Views Found Pop-Up Window 

 

2. Select a location view. 

3. Click OK. 
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 The Filter Count pop-up window displays. 

 

 
 

Filter Count Pop-Up Window 
 

4. Enter filter criteria in the fields provided. 

5. Click OK. 

 

 The Materials Mgmt: Physical Count window displays. 

 

 
 

Materials Mgmt: Physical Count Window 

 

6. Double-click on a result in the Count Number field. 
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 The result expands to display sheets of data. 

 

 
 

Sheets Displayed in the Materials Mgmt: Physical Count Window 

 

7. Select a sheet from the expanded view to view detail.  

8. Click on an item to view more information in the fields at the bottom of the window. 

 

Exercises 

1. Enter a requisition. 

2. Verify that the requisition has been submitted. 
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ASSESSMENT 

1. Which tab in PharmNet Pharmacy Medication Manager displays a detailed list of all medications for the 
selected resident? 

a. Acute Profile  

b. Ambulatory Profile 

c. Prescription History 

d. Unverified Orders Monitor 

 

2. Which of the following allergies apply to the resident named TrainPHARM PHARMResident4? (Select all 
that apply) 

a. Latex 

b. Soy Products 

c. Penicillin 

d. Ceclor 

 

3. What is the dosage for the Reglan order for resident named TrainPHARM PHARMResident4? 

a. 5 mg 

b. 10 mg 

c. 15 mg 

d. 20 mg 

 

4. A resident's height and weight can be updated within PharmNet Pharmacy Medication Manager. 

a. TRUE 

b. FALSE 

 

5. Which of the following are options in the Action drop-down on the Acute Profile tab? (Select all that 
apply.) 

a. Verify 

b. Approve 

c. Reject 

d. View Profile 

 

6. Where can you view the last time a medication was administered to a resident? 

a. Ambulatory Profile 

b. Acute Profile 

c. Demographics 

d. PowerChart 

 

7. If a medication is from a resident's own supply, it does not have to be verified in PharmNet Pharmacy 
Medication Manager. 

a. TRUE 

b. FALSE 

 

8. Search for requisition number 02032016-79012453 in Requisition. What is the item description? 
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a. LORazepam 2 mg/mL 1 mL injection  

b. escitalopram 10 mg Tab 

c. ranitidine 150 mg Tab 

d. LORazepam 0.5 mg Tab 

 

9. For which location is requisition number 02032016-79012453 requested? 

a. 211-AU_Infirmary 

b. 211-Dove Med Room 

c. 211-AU Pharmacy IP  

d. 211-Clinic 

10. On what date was requisition number 02032016-79012453 created? 

a. 3/2/2016  

b. 3/3/2016 

c. 6/2/2016 

d. 6/3/2016 
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APPENDIX A 

Cerner Icon Glossary 
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Pharmacy Icon Glossary 
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APPENDIX B 

Cerner Terms Glossary 

 

Term Definition 

Account Number A unique medical record number assigned to each resident or guarantor that remains 
with the resident regardless of the number of encounters. 

Active An element in the system is active when an action can be performed on it (such as 
clicking it or pressing ENTER). 

Activity Type 1. A division of a catalog type in the Order Catalog. For example, a catalog type of 

Laboratory can have activity types of General Laboratory, Blood Bank, Microbiology, and 

Anatomic Pathology. Activity types also can be subdivided into activity subtypes. For 

example, Anatomic Pathology may have the activity subtypes of AP Processing and AP 

Reports. Note - Each activity type is associated with a specific catalog type. Every item in 

the Order Catalog must have a catalog type and an activity type.  

AdHoc Charting Entering unscheduled results into the resident record. Only individuals with privileges to 

perform ad hoc charting can access the appropriate menu commands. 

AdHoc Pharmacy 
Order 

A pharmacy order added one at a time. 

Administration 
Time 

The time at which a medication, or continuous or intermittent order is administered to a 
resident. A nurse or other health care professional records the administration time on 
the medication administration record (MAR). 

Appointment 
Availability View 

Scheduling Appointment Book offers the option of displaying an availability bar that 
graphically depicts conflicts or available times during appointment scheduling. Duplicate 
appointment checking, interaction and sequencing rules, as well as advanced scheduling 
notification rules are used. 

Appointment 
Notification 

Notifications sent to specific routings or printers whenever an action such as confirm, 
modify, or cancel is performed on an appointment. Advanced appointment notifications 
can be defined where warnings are sent if an appointment is scheduled with inadequate 
advance notice according to predefined time limits. 

Authenticated The status of a document or result that has been approved or signed by the person 

ultimately responsible for it. The result or document is not considered final until it has 

been authenticated. 

Authentication The process that identifies users through the use of log-on names and passwords. 

Availability Conflict A system-detected difficulty in scheduling one or more requested appointments. This 
could be the result of person or resource availability checking. 

Available Physicians This window displays all available physicians whose last names agree with the starting 
value entered in the Physician Name field. 

Benefit Order The insurance plans for a resident. 

Billing Code An alphanumeric identifier assigned to an item to identify it to another system. Some 
examples are a CDM (Charge Description Master), which identifies items to a hospital 
billing system, and a CPT (Current Procedure Terminology), which identifies an item to 
most insurances and Medicare. 

Block Scheduling 1. An enhancement to scheduling slots and is useful for utilization of resources such as 

operating rooms. With scheduling blocks, you can determine a release time for that slot 
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or block of time to expire into a different slot. Reports can be run that analyze the data 

to determine the efficiency and utilization of the resources reserved in these blocks.  
The process of booking appointments to resource calendars composed of slots of a 
predefined time. Appointment slots have a single usage definition that does not change 
over time. Attempting to book a slot with an appointment request that does not match 
the definition of the slot will result in a warning message. Users with proper security 
may override this warning. 

Cancel Status Indicates that the transmission has been canceled. 

Canceled State A previously scheduled appointment type that has been removed from all resource 

schedules as well as the person schedule. Canceled appointments no longer occupy time 

for the originally booked person and resources. 

Care Coordination The Cerner Millennium solution that supports the care planning process and the delivery 

of the direct resident care that is defined in the plan of care. The solution can use clinical 

pathways, nursing care plans, and multiple-disciplinary plans of care. 

Cerner Millennium Cerner Millennium is Cerner's comprehensive suite of solutions that promote personal 

and community health management by connecting consumers, clinicians and healthcare 

organizations into a streamlined, unified single care process. Cerner Millennium 

applications work on a cohesive platform that is open, intelligent and scalable, allowing 

vital health information to be accessed and shared throughout the healthcare system. 

Chart Body The body of a chart that holds the diagnostic information entered for the procedures, 
administrative information associated with the procedures, or both. 

Chart In PowerChart, a chart is the aggregation of all information recorded about a person's 
health status. All inpatient and outpatient visits, lab results, procedures, evaluations, 
orders, reports, X rays, photographs, films, audio recordings, and other multimedia 
information pertaining to a person's health are considered part of the total chart. 
Historically, the chart has been paper-based. Recently, many institutions have begun 
storing resident information in databases accessible by computers, and the chart has 
become increasingly electronic. 

Charted Comments that can be posted in a chart or report. 

Computer-Based 
Training (CBT) 

Standard computer-based training may be purchased for those Cerner Millennium 
applications for which CBT is available; or a CBT can be custom-designed for a client as 
an optional service. 

Context Menu A menu that pops up when you right-click some elements. 

Comment A free-form narrative attached to a term in an encounter note using the Comment 

function. 

Continuous Order One of the three order types used in PharmNet. Continuous orders are intravenous 

orders marked by uninterrupted infusion over a period of time sufficient to require 

additional supplies of the product or products at regular intervals. For example, a large 

volume parenteral is a continuous order. The set of attributes required to correctly 

distinguish continuous orders from other order types includes interval, rate, and total 

volume. 

Co-Signer Person who signs off on a document to indicate that the contents of the document are 
accurate. 

Discontinued Order In PharmNet, a pharmacy order that was stopped by a physician, pharmacist, or 
clinician, or because its course of therapy has been completed. For example, an order 
can be discontinued for an antibiotic when the resident has completed the course of 
therapy. An order can also be discontinued by a clinician when a resident has an adverse 
drug reaction or does not tolerate the side effects of the medication. 
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Dosage 1. In PharmNet, dosage refers to the defined frequency, amount, strength, and quantity of 

doses of a medication. 

Dose 1. In PharmNet, dose refers to the amount of a drug or drug therapy. 

Downtime 
Sequence 

The sequence used by the system when it is assigning numbers during a system 
downtime. The pool of available numbers for this sequence should be separate from 
those used for the default sequence. 

Downtime Any period of time during which the system is unavailable to users. The cause is not 
relevant. 

Dispense In PharmNet, to prepare and distribute medications for a single order, as part of a fill list 
or batch, and to replenish the medication supplies. 

Electronic Medical 
Record (EMR) 

The electronic medical record replaces the resident's paper medical record. The EMR is 
at the heart of the automated health system. It allows resident records to be viewed and 
updated by numerous healthcare providers simultaneously. No longer are the residents' 
records inaccessible while waiting to be refiled. 

Electronic Signature The act of verifying or accepting a transcribed report online instead of signing the 
physical piece of paper on which the report is printed. 

Encounter A single resident interaction. The following interactions are examples of encounters: 
resident registered as an inpatient, resident registered as an outpatient. In the 
homecare setting, the following interactions are examples of encounters: resident 
admitted to home health, resident admitted to home infusion services. 

Encounter Number An internal number assigned by the system for each resident encounter. 

Encounter Type A classification of resident visit types. Examples include inpatient, outpatient, and 
emergency room. 

Encounter Note The textual documentation of a clinical encounter, such as inpatient, outpatient, or 
emergency. 

Encounter Access 
Method 

Person name, Person ID, Medical Record Number, and Social Security Number can be 
used to access encounter information. Person name and Person ID require the selection 
of an encounter if more than one exists on the person. Medical Record Number and 
Social Security Number are encounter identifiers, and directly access the appropriate 
encounter. 

Floor Stock Medications stocked at the care location. Also referred to as ward stock. Floor stock 
items typically are not included on fill lists. 

Free Text User-entered text, which is saved by the system. 

Free Text Field Free-text field types allow you to specify a free-text response. 

Future State A narrative or graphical description of how each type of process in the analyzed work 
area will work after improvements are completed. This future state may include 
targeted benefits and proposed processes to collect measurement data to monitor 
improvement. 

Go-Live Conversion or go-live is the process by which Cerner makes the system available to the 

client for the first production use. 

Immediate-Print 
Label 

A specimen label produced by the system as soon as an order is requested. This type of 
label is typically printed when specimens have already been collected for the orders, or 
when orders are requested with a stat collection priority. 

In-Process Status This status indicates those requests on which action has been taken but not completed. 

Intermittent Order One of the three order types used in PharmNet. Intermittent orders are intravenous 
orders defined by short periods of infusion that are interrupted before the next 
scheduled administration time. An intravenous piggyback is an example of an 
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intermittent order. The set of attributes required to correctly distinguish intermittent 
orders from other order types includes interval frequency, rate, infuse over value, and 
total volume. 

JCodes Billing codes associated with pharmacy charges used to identify specific ingredients and 
dosage in a given injection. It is defined in Charge Services as a bill code. 

Label Comment 1. Label comments are predefined messages created as a database to be shared with other 

applications. When you enter the corresponding code during order entry, the system 

displays the appropriate label comment.  

A textual comment that is to print on container labels or collection lists, depending on 
the customized label format. Label comments typically are entered when the order is 
requested, and serve as instructions to persons collecting or handling the specimen. 
Examples of label comments might be "Draw from right arm" or "Nurse will call when 
ready." 

Location Group A group of locations by which you can filter a list of tasks to be performed. For example, 
if you work in the locations 2N and 3N and these are defined together as a group, you 
could select this group when requesting your list of tasks. 

Lot Information Drug manufacturers and wholesalers routinely supply lot numbers and expiration dates 
for products. The ability to track lot numbers and expiration dates can be used in a 
variety of situations, including drug recalls. 

Medical Record 
Number (MRN) 

A permanent number used to identify the resident. It typically remains unchanged even 
if the resident has multiple encounters. 

Medication 
Administration 
Record (MAR) 

A report that serves as a legal record of the drugs and drug-related devices administered 
to a resident at a facility by a nurse or other healthcare professional. The nurse or 
healthcare professional signs off on the record at the time that the drug or device is 
administered. This report also documents that the appropriate therapy is provided to 
the resident. 

Medication Order One of the three order types used in the PharmNet system. Medication orders are 
distinguished by administration at a discrete moment in time, whether once or at 
regular intervals. Examples of medication orders include tablets, capsules, suppositories, 
and syringes. The presence of frequency, without rate, infuse over value, or total volume 
distinguishes medication orders from other order types. 

Multi-Choice Field 
Type 

Multi-choice field types allow you to specify at least one of several responses. 

Multiple Select To select more than one item, click the first and last items while pressing Shift, if they 
are listed sequentially. If they are not sequential, press CTRL and click each one 
individually. 

New Orders Display The area of the Orders view of the resident chart that displays all unsigned orders placed 
during a particular conversation. Also called the scratch pad. 

Order Category 
Display 

Orders are grouped and displayed in a hierarchy according to clinical interest. The site 
determines the hierarchy and the orders contained within it. 

Order Type Order Types are categories used to classify pharmacy products on the basis of how they 
are ordered, in particular, on the basis of a set of attributes that varies from one Order 
Type to the next. The three Order Types available for selection in the PharmNet system 
are continuous, intermittent, and medication. 

Outside Orders Outside order are those orders place in another order entry application, such as 
PowerChart, Departmental Order Entry, OSM Requisition Order Entry, or even from an 
interface with an external system. When the specimens are received in the laboratory, 
these orders are logged in using Maintain Case. 
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PharmNet PharmNet fully integrates with other clinical applications, automating medication use 
across the entire spectrum of medication management. 

Physician Name The first few letters of the last name of the consulting physician should be entered in 
this field. Upon doing so, the user can then click Search to reveal a list of physicians from 
which to choose. 

PowerChart The Cerner Millennium solution that is the enterprise clinician's desktop solution for 
viewing, ordering and documenting the electronic medical record. 

PowerOrders A physician order entry solution that gives appropriate access to real-time, relevant 
clinical information at any point in the care process. 

Proxy List This optional feature allows you to review, accept, and reject reports on behalf of 

another radiologist. 

Proxy A person designated to perform a task or review results for another health care 

provider. 

Refresh To replenish new information from the database and redisplay it within the current 
screen view. 

Resident Chart In Cerner Health Information Management, a resident chart is an encounter-level 
collection of resident information. The resident chart includes all documents, notes, and 
images pertaining to a single visit. 

Resident 
Demographics 

Information defined for the person or encounter. Demographic information includes 
elements such as the current location (nursing station, room, and bed, for example), 
alias identification values, age, birth date, gender, and maiden name. 

Resident 
Medication Profile 

A printed report that lists all of the drugs prescribed for a resident, which may contain 
active, suspended, or discontinued orders. The resident medication profile can be used 
to support the health care facility in case of a system failure or power outage to ensure 
that residents receive the appropriate drug therapy. 

Review (Orders) The process of checking an order for accuracy and appropriateness. Orders subject to 
nurse review are designated with an icon that resembles a pair of spectacles. The site 
defines which orders require nurse review. 

Review (Results) To verify a result. Results entered in the flowsheet become part of the resident record. 
Whether the result records a discrete task assay, document, or laboratory value, the 
person ultimately responsible for its accuracy must verify or review the result and sign it. 
When signed by the appropriate person, the result has the status of Authenticated 
(final). 

Reviewer Additional person who receives a copy of a document for review. 

Schedulable Any item that can be scheduled to a resource or person appointment schedule. 

Schedule The process of creating an appointment request, booking the request to one or more 
persons or resources, and confirming the booked requests. 

Scheduled A medication order that has fixed dose times. The times can be fixed to always occur at 
the same time of day or be determined by the system based on an interval. These are 
usually identified by standard frequency codes, such as bid (twice daily at 0800 and 
1600) or q8h (every eight hours starting from 10 a.m.). 

Scratch Pad The new order area of the Orders view of the resident chart. All unsigned orders placed 
during an order conversation are displayed on the scratch pad until they are signed and 
submitted. 

Selected Physicians This window displays the names of physicians who have been chosen from the Available 
Physicians window. 

Selection Criteria Variables that determine which residents are included in a distribution. 

Soft-Stop Soft-stop review policies are implemented to notify the prescriber that a medication 
order requires review, but the medication actually will not be discontinued if the 
situation is not addressed by the prescriber. 
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Sorts Sorts are used to put data in a particular order. 

Subclass A subclass is a method to categorize or group interesting case files. Subclasses allow 
radiologists or residents to group certain interesting case files together and assign a 
name to that group. Subclasses are personal or shared. 

Summary Sheet Used to display a summary of the resident's health history to the healthcare provider. 

Tab A window element resembling a folder tab that is used to group similar information. 

Task Type Task types are used to group similar, individual tasks together. For example, a task type 
of dietary might contain all dietary tasks such as clear liquid diet, soft diet, and so on.  

Toolbar A window element containing buttons or other window elements to facilitate 
accomplishing a task. 

Tooltip A description displayed when you move the cursor over a button in the toolbar. 

Unauthenticated The status of a document or result that has not been approved or signed by the person 
ultimately responsible for it. The result or document is not considered final until it has 
been authenticated. 

Uncommitted Data Data that has been entered but not saved or signed. Sometimes, uncommitted data is 
displayed in a special color until it is saved. If the user attempts to close a window or exit 
an application with uncommitted data, a system prompt warns that this data will be lost. 

Untransmitted The report has not been transmitted. 

Unverified Order In PharmNet, an order entered in the system by a pharmacy technician or other 
healthcare professional that must be verified by a pharmacist. Unverified orders include 
all pharmacy order types---continuous, intermittent, and medication. 

Verify To confirm that the result entered for a procedure is correct. The process of verifying 
updates the status of the result to Complete. Results of procedures are not available for 
general inquiry, transmission, or charting purposes until verification occurs. 

Wildcard A character that allows a search over a wide range of related data elements. 

Worklist A list of orders that need to be completed. 

Worklist ID The worklist ID is an identifier that is assigned to a specific worklist. The date and time is 
also stamped with the worklist ID so that if the same worklist ID is used multiple times, 
the date and time will differentiate each worklist ID. 

Worklist Name The worklist name is the name assigned to a predefined set of selection criteria for the 
worklist. 

 
 


